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You may have already used a filter or two in 
Photoshop (perhaps as a step in an earlier 
chapter). In this chapter, filters are the star 
players. Depending on which filters you apply and 
which settings you choose, the results can range from a 
subtle change to a total morph.A–B You can make an 
image look (almost) as if it’s hand painted, silk-screened, 
or sketched; apply distortion; add a pattern, texture, 
or noise; create a mosaic or a patchwork of tiles — the 
creative possibilities are infinite. Once you start using  
the Filter Gallery, you’ll see … time will fly by.

Using this chapter, you will learn techniques for  
applying filters, including using the Filter Gallery and 
Smart Filters, and use filters to make a photo look like an 
oil painting or tinted drawing. (To locate tasks in which 
we use individual filters, see “Filter menu” in the index.)

Applying filters
You can apply filters to a whole layer or just to a selec-
tion on a layer. Most of the Photoshop filters are applied 
either via the Filter Gallery or via an individual dialog. 
A small handful of them, such as Clouds and Blur, are 
applied in one step simply by choosing the filter name 
from a submenu on the Filter menu. If you apply a filter 
to a Smart Object, it becomes an editable, removable 
Smart Filter (see pages 344–345).

If you try to select a filter and discover that it’s not 
available, the likely cause is that it’s incompatible with 
the current document color mode or bit depth. All the 
Photoshop filters are available for RGB files, most of the 
filters are available for Grayscale files, fewer are available 
for CMYK Color, Lab Color, and 16-bits-per-channel files, 
still fewer are available for 32-bits-per-channel files, and 
none are available for Bitmap and Indexed Color files. 

A This is the original image. B We applied the Charcoal filter.
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Most of the Photoshop filters are housed conve-
niently under one roof in the Filter Gallery dialog. 
There you can preview dozens of  filters and filter 
settings, show and hide each filter effect that you’ve 
already previewed, and change the sequence in 
which Photoshop applies them to your document.

To use the Filter Gallery:
1. Click an image layer; or for more flexibility, click a 

duplicate image layer or a Smart Object (see “To 
apply a Smart Filter” on page 344). 

2. Optional: To limit the filter to a specific area of 
the image, create a selection.

3. The Foreground and/or Background colors are 
used by many filters (see the sidebar on this 
page), and you must choose those colors now, 
before opening the Filter Gallery. 

4. Choose Filter > Filter Gallery. The resizable 
gallery opens (A, next page).

5. To change the zoom level for the preview, click 
the Zoom Out button  or Zoom In button   
in the lower-left corner of the dialog, or choose a 
preset zoom level from the menu. (If the preview 
is magnified, you can drag it in the window.)

6. Do either of the following:

 In the middle pane of the dialog, click an arrow-
head to expand any of the six filter categories, 
then click a filter thumbnail.

 Choose a filter name from the menu below the 
Cancel button.

7. On the right side of the dialog, choose settings 
for the filter.

8. To edit the list of effects (bottom right portion of 
the dialog), do any of these optional steps: 

 To apply an additional filter effect, click the New 
Effect Layer button,   click a filter thumbnail 
in any category, then choose settings. The effect 
may take a moment or two to process.

 To replace one filter effect with another, click a 
filter effect name on the scroll list (don’t click the 
New Effect Layer button), then choose a replace-
ment filter and settings.

 To hide a filter effect, click the visibility icon  
next to the effect name (click again to redisplay).

 To change the stacking position of a filter effect 
to produce a different result in the image, drag 
the effect name upward or downward on the list. 

 To remove a  filter effect from the list, click it, then 
click the Delete Effect Layer button. 

9. Click OK. 

 ➤ To hide or show the previews in the Filter Gallery 
for all but one filter effect, Alt-click/Option-click 
the visibility icon for that effect.

 ➤ To remove a non-Smart Filter, click a prior docu-
ment state or snapshot on the History panel. 

 ➤ In Edit/Photoshop > Preferences > Plug-Ins, 
uncheck Show All Filter Gallery Groups and 
Names to list, on the submenus on the Filter 
menu, only filters that are not in the Filter Gallery, 
or check this option to list all Photoshop filters 
on the submenus, including those that are avail-
able in the Filter Gallery (the gallery opens when 
you choose a filter name).★

filters that use the foreground and 
background colors
The filters listed below use the current Foreground 
and/or Background colors. Some filters, such as 
Charcoal, Graphic Pen, and Photocopy (in the Sketch 
category), look good in the default Photoshop 
colors of black and white, whereas others look 
better in color. But don’t just take our word for it —  
experiment and see for yourself.

 ➤ Artistic > Colored Pencil (Background color), 
Neon Glow (Foreground and Background colors)

 ➤ Distort > Diffuse Glow (Background color)

 ➤ Pixelate > Pointillize (Background color)

 ➤ Render > Clouds, Difference Clouds, Fibers 
(Foreground and Background colors)

 ➤ Sketch > Bas Relief, Chalk & Charcoal, Charcoal, 
Conté Crayon, Graphic Pen, Halftone Pattern, Note 
Paper, Photocopy, Plaster, Reticulation, Stamp, Torn 
Edges (Foreground and Background colors)

 ➤ Stylize > Tiles (Foreground or Background color)

 ➤ Texture > Stained Glass (Foreground color)

reapplying the last filter quickly
 ➤ To reapply the last-used filter(s) using the same 

settings, choose Filter > [last filter name or Filter 
Gallery] (Ctrl-F/Cmd-F). 

 ➤ To reopen either the last-used filter dialog or the 
Filter Gallery showing the last-used settings, press 
Ctrl-Alt-F/Cmd-Option-F.



Filters  343 

A The Filter Gallery dialog includes a preview area, filter categories (with thumbnails), settings for the currently selected filter 
effect, and a listing of the currently applied effects.

Hide or show a filter effect previewZoom controls

Click this button to hide or show the thumb-
nails and expand or shrink the preview area.

New Effect Layer

To preview a filter effect, click a thumbnail 
or choose a filter name from the menu.

using the preview in an individual filter dialog

Preview 
window

Zoom Out 
and Zoom 
In buttons

Some Photoshop filters are applied via an individual 
dialog (not via the Filter Gallery). Of those individual 
dialogs, some have a preview window and some do not.

 ➤ For individual filter dialogs that contain a preview 
window, you can click the + button to zoom in or the  
– button to zoom out (we usually do the latter). Most of 
the individual dialogs also have a Preview check box. 

 ➤ In some filter dialogs (such as Blur > Gaussian Blur 
and Motion Blur), if you click in the document window 
(square pointer), that area of the image will appear  
in the preview window. You can drag the image inside 
the preview window. 

 ➤ To compare the image with and without the current 
filter effect, click and hold on the preview, then release. 
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Creating and editing Smart Filters
When you apply a filter to a Smart Object, it becomes 
what is called a Smart Filter. You can edit or remove a 
Smart Filter at any time, apply multiple filters to the 
same Smart Object, hide individual filters while keep-
ing others visible, and move or copy filters from one 
Smart Object to another. You can also edit the filter 
mask (which is created automatically), change the  
stacking order of the filters, and edit the Smart Object  
itself. To learn about Smart Objects, see pages 248–255.

The file formats that support Photoshop layers —  
such as PSD, PDF, and TIFF — also support Smart Filters. 
Some third-party (non-Adobe) filters can also be 
applied as Smart Filters.

To apply a Smart Filter:
1. On the Layers panel,  do either of the following:

 Click an existing Smart Object.

 Click an image layer, then choose Filter > Convert 
for Smart Filters (or right-click the layer and 
choose Convert to Smart Object). If an alert 
appears, click OK.

2. Optional: Create a selection to control which area 
of the image the filter affects. (The selection shape 
will appear in the filter mask once you apply a 
filter.)

3. Apply a filter. A Smart Filters listing, mask 
thumbnail, and filter listing will appear on the 
Layers panel.A (Note: Filter > Liquify and Filter > 
Vanishing Point can’t be applied as Smart Filters.)

The most significant advantage to using Smart Filters 
is that you can edit the filter settings at any time.

To edit the settings for a Smart Filter:
1. Do either of the following:

 Double-click on or next to the Smart Filter name 
on the Layers panel.

 Right-click the Smart Filter name and choose Edit 
Smart Filter from the context menu.

2. If any Smart Filters are listed above the one you’re 
editing, an alert will appear, indicating that those 
filter effects will be hidden until you exit the Filter 
Gallery or filter dialog.B Check Don’t Show Again 
to prevent the warning from appearing again (if 
desired), then click OK.

3. Make the desired changes in the filter dialog, then 
click OK.

B If you edit a Smart Filter and other filters are listed 
above it on the same layer, this alert dialog appears.

changing the color mode or bit depth
When changing the document color mode or bit 
depth, if the image contains Smart Filters that aren’t 
supported by the new mode or depth, an alert will 
appear (shown below). If you click Don’t Rasterize and 
then click Don’t Flatten or Don’t Merge, this symbol  
will display next to the filter names on the Layers 
panel, signifying that the filter effect is inaccessible. 
If you then convert the file to a mode or depth that 
does support the filter (and respond to the alerts 
the same way), the icon will disappear and the filter 
settings will be editable again. 

A If you apply a Smart Filter by choosing Filter > 
Filter Gallery, the filter will be listed as “Filter Gallery,” 
whereas if you apply a Smart Filter by choosing its 
individual name, it will be listed by its name.

This icon signifies 
that this Smart Object 
contains filter effects
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Not only can you change the blending mode and 
opacity of a Smart Object, you can also change the 
blending mode and Opacity setting of each Smart 
Filter that is applied to that object. Granted, this can 
be a lot to keep track of. And unfortunately, there is no 
indicator on the Layers panel to let you know if those 
settings have been changed from the defaults.

To edit the blending options for a Smart 
Filter:
1. Double-click the Blending Options icon  next to 

a filter name on the Layers panel,A–B then click 
OK if an alert dialog appears. 

2. The Blending Options dialog opens.C Check 
Preview and, if desired, lower the zoom level. 
Change the blending Mode and/or Opacity (use 
the latter to fade the filter effect), then click OK.D

Hiding, copying, and deleting 
Smart Filters
To hide (or show) Smart Filter effects:
 Do either of the following:

 Click the visibility icon  for the Smart Filters 
listing to hide all the Smart Filters on that layer.

 Click the visibility icon  for any individual Smart 
Filter. This may take longer to process than clicking 
the visibility icon for all the filters.

 Click where the icon formerly was to redisplay the 
hidden filter effects.

To copy Smart Filters from one Smart 
Object to another:
1. Expand the list of Smart Filters for a Smart Object.

2. Alt-drag/Option-drag either the Smart Filters list-
ing or an individual filter listing to another Smart 
Object.

 ➤ You can restack any Smart Filter within a Smart 
Object list (pause for the edit to process). 

 ➤ If you drag a filter or the Smart Filters listing from 
one Smart Object to another without holding 
down Alt/Option, the filters will be removed from 
the source layer and added to the target layer. 
Any preexisting filters on the target layer will be 
preserved. Pause for the edit to process.

D Now more of the Dry Brush filter is showing through.

A We applied the Fresco and Dry Brush filters to this image.

B We double-clicked 
the Blending Options 
icon for the Fresco filter 
on the Layers panel.

C Via the Blending Options dialog, we 
lowered the opacity of the Fresco filter.
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If you delete a Smart Filter from a Smart Object that 
contains multiple filters, it may take a moment or two 
for Photoshop to update the display.

To delete a Smart Filter:
 Do either of the following:

 Right-click a Smart Filter listing and choose Delete 
Smart Filter.

 Drag a Smart Filter listing to the Delete Layer 
button. 

Working with the Smart Filter 
mask
When you apply a filter to a Smart Object, a filter mask 
appears on the layer automatically. If you create a 
selection before applying the first filter to a Smart 
Object, the selection will appear as the white area in 
the mask. A filter mask can also be edited using the 
same methods as for a layer mask. For an illustration of 
how this works, see the next two pages.

To edit a filter mask:
1. Click the filter mask thumbnail.

2. Do either of the following:

 Click the Brush tool,  then apply strokes with 
black to hide the filter effect, or with white to 
reveal areas you’ve hidden. For a partial mask, use 
black and lower the tool opacity (A–E, next page).

 To hide the filter effect gradually from one side of 
the image to the other, click the Gradient tool,  
then drag across the image (A–C, page 348).

 ➤ To display the filter mask by itself in the document, 
Alt-click/Option-click the mask; repeat to redisplay 
the full Smart Object.

 ➤ To soften the transition between black and white 
areas in a filter mask, click the filter mask thumb-
nail, then on the Properties panel,  adjust the 
Feather value. To control the overall opacity of the 
mask, use the Density slider.

diminishing a filter effect
To reduce the effect of a Smart Filter, lower its opac-
ity via the Blending Options dialog. Or if you applied 
the filter to a duplicate image layer (not to a Smart 
Object), lower the opacity of the upper layer.

solving memory problems
If you encounter memory problems when applying 
filters (Photoshop memory, that is, not your own 
forgetfulness!), try choosing Edit > Purge > All to free 
up memory, or exit/quit other open applications. Also 
bear in mind that the processing time may vary for 
any given filter slider or option. For instance, a higher 
setting that produces many small shapes may take 
longer to process than a setting that produces just a 
few large shapes.

If for some reason a filter mask was deleted and you 
want to restore it, do as follows.

To create a filter mask:
1. Optional: Create a selection.

2. Right-click the Smart Filters listing on the Layers 
panel and choose Add Filter Mask.

To deactivate a filter mask temporarily:
 Shift-click the mask thumbnail (a red X appears 

over the thumbnail). Repeat to reactivate the mask.

To delete a filter mask:
 Do either of the following:

 Drag the filter mask thumbnail to the Delete Layer 
button  on the Layers panel. 

 Click the filter mask thumbnail, then on the 
Properties panel, click the Delete Mask button. 
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C We reduced the Opacity of the Smart Object to 62%.

A This is the original image.

D We clicked the filter mask, then with the Brush tool at 
50% Opacity and black as the Foreground color, applied 
strokes to partially restore the tiger’s face to its virgin state.

working with smart filters: an example

Continued on the following page

E This is the Layers panel for the image 
shown at left.

B We duplicated the Background, 
converted the copy to a Smart 
Object, pressed D to reset the 
default Foreground and Background 
colors, then applied Filter Gallery > 
Sketch > Charcoal (values at left).
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B With the Gradient tool (100% Opacity, 
“Black,White” preset, radial type), we 
dragged from the center of the image 
outward. The filter effect is at full strength 
where the mask is white, and it fades to 
nil where the mask is black.

A Next, to wipe the filter mask clean so we could try 
a different approach, we clicked the mask thumb-
nail, pressed Ctrl-A/Cmd-A to select the whole mask, 
pressed Backspace/Delete, then pressed Ctrl-D/Cmd-D 
to deselect.

C The gradient in the filter mask is diminishing the 
impact of the filter in the center of the image — the 
tiger’s face — right where we want the focal point to be.
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More filter techniques
If you apply filters to a Smart Object, you can easily change the 
settings — and will feel more free to experiment. If you come up 
with a filter formula that you like, record your steps in an action. 
Here are a few more suggestions:

 ➤ Filters tend to make an image more abstract, reducing recog-
nizable elements to line work, or to fewer or flatter areas of 
color. Start with an image that has a strong composition. Look 
for shapes that contrast in scale and have interesting contours, 
which will carry more weight once you apply filters.

 ➤ Use an adjustment layer above the filtered layer to fine-tune the 
resulting luminosity levels or colors.A–D

 ➤ Apply filters separately to a Smart Object one by one, then via 
the Blending Options dialog, lower the opacity of the topmost 
filter and/or change its blending mode. You can also apply 
filters to separate layers, then change the layer opacity or blend-
ing mode of any layer (A–E, next page). 

 ➤ For less predictable and “machine made” results, apply two or 
more filters that have contrasting or complementary effects. For 
instance, you could apply one filter that reduces shapes to line 
work (such as Poster Edges) and another filter that changes the 
color or applies an overall texture, such as Grain > Texturizer. 

 ➤ For a personal touch, apply some paint strokes (A–C, page 351).

A We duplicated the Background in this 
image, then converted the duplicate layer 
to a Smart Object.

B We applied Filter > Filter Gallery > 
Diffuse Glow.

C We created a Black & 
White adjustment, then 
lowered the opacity of the 
adjustment layer to 52%.

D This is the final image.

filters and an adjustment 
layer
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A We converted a duplicate of the 
Background to a Smart Object.

E This is the final image.

B We applied Filter > Other > Minimum 
(Radius 1), then Filter > Stylize > Find Edges.

C We changed the blending mode 
of the Smart Object to Linear Burn.

D We created a second duplicate of the 
Background, moved the duplicate to the top 
of the Layers panel, changed the blending 
mode of that layer to Divide, and lowered its 
Opacity to 50%. Finally, we used a Vibrance 
adjustment to boost the colors slightly.

filters, an adjustment layer, and blending modes
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a texture filter and paint strokes

A This is the original image.

B This is the Layers 
panel for the final image.

C This is the image after we converted a duplicate image layer to a Smart Object, applied the Texturizer 
filter (Burlap texture) via the Filter Gallery, and used the Mixer Brush tool (Sample All Layers checked) to 
apply paint strokes to six new layers. We also applied the Drop Shadow effect to a couple of the paint 
layers for added depth, and a Levels adjustment to heighten the contrast in the underlying image.
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Turning a photo into a painting  
or a drawing
The Oil Paint filter turns a photo into a quasi oil paint-
ing. You can’t vary the size or direction of the brush 
strokes in different parts of the image, but it does 
produce some rich textural effects — and it’s a fun 
filter to play with. Note: For this filter to work, Use 
Graphics Processor must be checked in Preferences > 
Performance.

To turn a photo into an oil painting: ★
1. Duplicate an image layer in an RGB image, then 

right-click the duplicate and choose Convert to 
Smart Object. Keep the Smart Object selected.A

2. Choose Filter > Oil Paint. In the Oil Paint dialog, 
zoom in on the preview so you’ll be able to 
examine the shape of the brush strokes.B

3. Under Brush and Lighting, adjust the sliders:

 Stylization controls the smoothness of the strokes.

 Cleanliness controls the purity of (amount of color 
variegation in) the colors.

 Scale controls the width of the strokes.

 Bristle Detail controls the visibility of bristle marks 
in the paint strokes. 

 Angular Direction controls the position of the 
highlights on the paint surface.

 Shine controls the intensity of highlight reflections  
on the paint surface. This slider has a strong impact.

4. Click OK C (and A–D, next page).

C This is the final 
“oil painting.”

B We chose these values in the Oil Paint dialog.

A This is the original photo.
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A In this image, we converted a duplicate of the Background to a Smart 
Object.

C We lowered the Opacity of 
the Smart Object to 66%, then 
used a Levels adjustment layer 
to boost the contrast and a 
Vibrance adjustment layer to 
boost the color intensity slightly. 

D The Palette Knife filter contributes an irregular texture to the Oil Paint effect.

the oil paint filter plus the palette knife filter and adjustments

B To the Smart Object, we applied 
the Palette Knife filter (Filter Gallery), 
then the Oil Paint filter (settings shown 
above). 
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In these steps, you’ll turn a photo into a watercolor by 
applying a series of filters. Try devising some of your 
own formulas, too!

To turn a photo into a tinted drawing:
1. Duplicate an image layer in a high-resolution 

photo.A
2. Choose Filter > Stylize > Find Edges.B
3. Choose the Brush tool.  Choose a large, Soft 

Round brush, Normal mode, and an Opacity below 
50% on the Options bar. Also make the Foreground 
color black. 

4. Click the Add Layer Mask button  on the Layers 
panel, then with the layer mask thumbnail selected, 
apply strokes to the image to reveal areas of the 
underlying layer.

5. Do any of the following optional steps:

 Lower the Opacity of the duplicate layer.

 Change the blending mode of the duplicate layer 
(try Lighter Color, Color Dodge, Hard Light, Pin 
Light, or Luminosity).C–D

 Intensify the contrast via a Levels adjustment layer.

C This is the Layers panel for the final 
image, which is shown at right.

D We applied brush strokes to the layer mask to reveal some 
of the underlying image, and chose Hard Light as the blend-
ing mode for the duplicate layer.

A We duplicated the 
Background in this 
original image.

B We applied the Find Edges filter 
to the duplicate layer.
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menu item insertion, 402
modal controls, 403
playback options, 397
playing on batch of images, 398–399
playing on one image, 397
recording, 395–396
renaming, 401
rerecording, 403
ruler units in, 396
sets, 404
Stops, inserting, 401
use suggestions, 399

Actions panel
Button mode, 397
Dialog icon, 403
illustrated, 104, 395
Insert Menu Item command, 402
Insert Stop command, 401
List mode, 395, 397
loading set onto, 404
New Action button, 396, 401
Play button, 397
Playback Options command, 397
Record Again command, 403
Reset Actions option, 404
Save Actions command, 404

Add Clips dialog, 429
Adjustment Brush tool (Camera Raw)

accessing, 72
Auto Mask option, 74
defined, 56
edits, removing, 74
local edits with, 72–74

Adjustment layer presets
choosing, 202

deleting, 206
saving, 206

Adjustment layers
applying to video clips or tracks, 430
Black & White, 226–228, 349
Brightness/Contrast, 212
clipping, 205
Color Balance, 216–217, 317
creating, 114, 202–203
Curves, 215, 222–225
defined, 112
deleting, 206
editing, 114
effects, hiding, 204
Gradient Map, 228–229
Hue/Saturation, 218
identifying, 203
Levels, 210–211, 238
mask, editing, 207
merging, 148, 206
new edits, viewing images without, 

204
options on Properties panel, 114
Photo Filter, 213
settings, editing, 204
settings, restoring, 204
unclipping, 430
Vibrance, 219–221

Adjustments panel
Auto-Select Parameter option, 205
Black & White button, 226
Brightness/Contrast button, 212, 406
buttons, 105, 202
Color Balance button, 216
Curves button, 215, 222
Gradient Map button, 228
Hue/Saturation button, 218, 292
illustrated, 105
Levels button, 210, 215, 238, 367
Photo Filter button, 213
Reset to Adjustment Defaults  

button, 204
Vibrance button, 219, 220, 221
View Previous State button, 204

Adobe Bridge. See Bridge
Adobe Illustrator. See Illustrator, Adobe
Adobe InDesign. See InDesign, Adobe
Adobe RGB color space, 5–6
Advanced preferences (Bridge), 446

Airbrush tips, 276
Alert dialogs

resetting all, 435
upon opening a file, 35

Aligning
edges, for shape tools, 388
layers, with Auto-Align Layers 

command, 266–267
layers, with one another, 261
with Smart Guides, 143
type, 364
vector shapes, 391

Alpha channels
editing, 164
layers while recording actions, 396
loading as selection, 164
saving selections as, 164
thumbnails, 317

ANPA colors, 187
Anti-aliasing 

selection tools and, 159
type tools and, 356

Application frame
defined, 85
docking document windows into, 87
illustrated, 85, 86
Mac OS, 86
minimizing, 86
redocking floating panels into, 95

Art History tool, 102
Artistic borders, 408–409
Assign Profile dialog, 12
Audio clips, 432
Auto Color Correction Options dialog

accessing, 214
Enhance Brightness and Contrast 

algorithm, 215
Find Dark & Light Colors algorithm, 

214
Auto-Align Layers dialog, 266–267
Auto-Select Parameter option, 205

B
Background

converting layer to, 138
converting to layer, 138
deleting selection from, 154
document, choosing for new, 15
duplicating, 280, 423
filling selection on, 154

Unless noted otherwise, the listings in this index pertain to Photoshop.
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moving upward on list, 140
shade around canvas area, 92

Background color
choosing, 185, 186, 189
filters using, 342

Background Eraser tool, 102
Baseline shift, 363
Basic blending modes, 191
Basic tab (Camera Raw)

Clipping Warning buttons, 62
color saturation adjustments, 65
contrast adjustments, 62–64
defined, 61
dual exposure, 256–257
edge contrast adjustments, 65
exposure adjustments, 62–64
illustrated, 59
sliders, updating, 60
using, 61–65
white balance adjustments, 61

Batch dialog, 397–398
Batch Rename dialog (Bridge), 44
Bevel effect, 374–375
Bit depth

changing, 344
Photoshop channels and, 2

Bitmap images, 2
Bitmap mode, 4
Black & White adjustment layer

filters and, 349
grayscale conversion via, 226–228
Targeted Adjustment tool, 226
tints, 226, 228

Blemishes, removing, 297
Blemishes, removing (Camera Raw), 80
Blending layers

blending modes for, 191–192
Blending Options, 330–331
modified with original one, 329

Blending modes
brush, 271
categories, 191
choosing, 191–192, 329
cycling through, 192
list of, 191

Blending Options, 
for layers, 330–331
for Smart Filters, 345

Blur filters
Field Blur filter, 312, 313, 317
Gaussian Blur filter, 300–301

Iris Blur filter, 312, 314, 317
Lens Blur filter, 309–311
Motion Blur filter, 320–321
Surface Blur filter, 299
Tilt-Shift filter, 312, 315, 317

Blur Gallery filters
Field Blur filter, 312, 313, 317
Iris Blur filter, 312, 314, 317
Tilt-Shift filter, 312, 315, 317

Blur masks, 312
Blur tool, 102
Bokeh options in Blur Gallery, 312, 316
Bridge

cache, exporting, 50
collections, 46–47
Collections panel, 26, 46–47
Content panel, 26, 30, 36, 37
Favorites panel, 26, 30, 45
file management, 43–44
file searches, 45
Filter panel, 26, 41
Folders panel, 26, 30
image previews in, 30–33
keywords, 38–39, 446
Keywords panel, 26, 38–39
launching, 23
loupe, 

preference setting for, 444
using, 32

metadata display, 37
Metadata panel, 26, 39
Metadata placard, 30
Mini Bridge, 48–49
navigation controls, 30
opening files from into Photoshop, 

34–35
Options for Thumbnail Quality and 

Preview Generation menu, 31
Output panel, 412, 415, 416, 418–419
Output Preview panel, 420–421
panes and panels, customizing, 36
PDF contact sheet via, 418–419
Photo Downloader, 24–25
Preferences, 444–446
Preview panel, 26, 30
previews, 30–33
Refine menu, 33
Review mode, 33
thumbnails, 30, 31, 32, 36, 40–43
uses, 23
View Content buttons, 37
Web Gallery upload via, 416

window customization, 36–37
window features, 26–27
window illustration, 27
workspaces

choosing, 28–29
resetting, 38
saving, 38

Brightness/Contrast adjustments, 212
Bristle brushes

building, 278
paint options, 279
wiping clean, 279

Brush panel
Airbrush tips, 276
Angle option, 273
Brush Pose option, 278
Brush Projection option, 274
Brush Tip Shape option, 273, 275, 276
Color Dynamics option, 274
Create New Brush button, 275
customizing brushes via, 273–275
Erodible Point tips, 275–276
Hardness option, 273
illustrated, 105, 273
Live Tip Brush Preview button, 275
New Brush button, 116
quick access to, 277
Roundness option, 273
Scattering options, 274
Shape Dynamics option, 274
Size option, 273
Spacing option, 274
Texture option, 275
Transfer option, 275
uses, 105

Brush Preset picker, 271, 272, 290–291
Brush presets

deleting, 277
exporting/importing, 118
loading, 277
managing, 277
names, viewing, 281
resetting, 277
settings, 277

Brush Presets panel
defined, 106
illustrated, 106
Live Tip Brush Preview button, 275
Open Preset Manager button, 119
quick access to, 277
saving brushes from, 117
using, 277
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Brush strokes, recording in actions, 396
Brush tool

Airbrush tip, 276
applying Quick Mask with, 171
burning areas with, 233
defined, 101
dodging areas with, 233
editing filter mask with, 346, 347
editing layer masks with, 173, 260, 354
editing Quick Mask with, 170
Erodible tip, 275–276
Options bar, 170, 173, 207, 233, 

271–272
using, 271–272

Brushes
blending modes and, 271
bristle, 278–279
customizing, 116, 273–276
diameter, 258, 290, 320
flow rate, 271
hardness, 272
opacity, 271, 272
saving, 117, 119, 277
size, changing, 272, 273
temporary settings, 272
tips, 273–276

Burn tool, 102
Burning, 233

C
Cache (Bridge), 50
Cache preferences (Bridge), 446
Calibration, display, 7
Calibrators, 7
Camera Raw

Adjustment Brush tool, 56, 72–74
advantages to using, 51–52
Basic tab, 59, 60, 61–65
Crop tool, 56, 57
default settings, restoring, 59–60
Detail tab, 58–59
editing Smart Objects in, 254, 

256–257
Effects tab, 76–77
Graduated Filter tool, 56, 78–79
HDR file processing in, 237
host selection for, 54
HSL/Grayscale tab, 59, 70–71
multiple files open in, 83
noise reduction, 68
opening files from, as Smart  

Objects, 249

opening photos into, 54–55
presets, applying, 81
presets, saving, 81
previews, 52, 56
Red Eye Removal tool, 56
scrubby-sliders, 59
settings, applying to multiple  

photos, 82
settings, removing, 82
settings, restoring, 59–60
settings, saving as preset, 81
settings, synchronizing, 83
Settings menu, 60, 81
sharpening, 52, 68
Snapshots, 81
Split Toning tab, 75
Spot Removal tool, 56, 80
Straighten tool, 56, 57
Targeted Adjustment tool, 66, 71
toggling preview in, 59
tonal redistribution, 52
Tone Curve tab, 59, 66–67
tools, 56
updating, 53
white balance, 60–61
White Balance tool, 56
workflow settings, 58
zoom methods, 56

Cameras
Adobe RGB color space, 5–6
capturing tonal values (Camera 

Raw), 52
downloading photos (Bridge), 24–25

Canvas
area, enlarging with Crop tool, 132
pixels outside of, 241
size, changing, 126
view, rotating, 91

Canvas Size dialog, 126
Channels

alpha, 164, 170, 317, 396
Curves adjustment layer, 224
default number, 2, 3
defined, 2
document color mode and, 3
spot color, 370

Channels panel
document color modes and, 3
illustrated, 106
Load Channel as Selection button, 164
New Spot Channel command, 370
Save Selection as Channel button, 164

uses, 106
Character panel

Baseline Shift controls, 363
Color swatch, 359
displaying, 107
East Asian Features, 357
Font Family, Font Style menus, 359
Font Size menu, 360
illustrated, 107, 355
Kerning controls, 361
Leading controls, 362
Middle Eastern Features, 357
OpenType buttons, 363
Options bar, 359
resetting, 361
showing, 359
Tracking controls, 361

Character Styles panel
illustrated, 107
New Character Style button, 365
Refine Style command, 365
uses, 107

Charcoal filter, 342
Clipboard

New dialog and, 16
Paste commands, 240, 242
purging, 240
using, 239–242

Clipping
adjustments, 205
high-contrast display of, 210–211, 222

Clipping masks
creating, 327–328
releasing, 328
releasing layers from, 328
using, 327–328

Clone Source panel
illustrated, 108
multiple source documents, 262
source overlay transformations, 263
uses, 108
using, 262, 303

Clone Stamp tool
defined, 101
Options bar, 302–303
using, 262–263, 302–303

Cloning, retouching by, 302–303
CMYK Color mode

channels, 3
conversion, 3, 4, 457
defined, 3, 4



472  Index

output, final corrections in, 457
soft-proofing, 449

CMYK model
in color selection, 186
defined, 2

Collections (Bridge)
adding thumbnails to, 47
contents, displaying, 46
creating, 46–47
deleting, 46
naming, 45, 46
relinking missing files to, 47
removing thumbnails from, 47
from search results, 45
Smart, creating, 46
Smart, editing, 46

Collections panel (Bridge)
in creating collections, 46–47
defined, 26

Color Balance adjustment, 216–217, 
317

Color corrections
auto, 214–215
Color Balance adjustment, 216–217
Curves adjustment, 224–225
display calibration and, 201
Hue/Saturation adjustment, 218–219
Match Color command, 286–287
Photo Filter adjustment, 213
Vibrance adjustment, 219–221

Color Libraries dialog, 185, 187
Color management

benefits of using, 5
Color Handling menu, 452, 453
color modes and, 3–4
introduction to, 5
Output options, 454
Photoshop, benefits of, 453
policies, customizing, 10
settings, 452
turning off for printer, 455–456

Color modes, document
Bitmap, 4
channels and, 3
CMYK Color, 3, 4, 201, 457
conversions, 3
Grayscale, 4
Indexed Color, 4
Lab Color, 4
RGB Color, 3, 4, 201, 447
and Smart Filters, 344

Color noise reduction (Camera Raw), 
68–69

Color panel
choosing colors with, 185
illustrated, 108
out-of-gamut alert, 188

Color Picker
choosing colors with, 185
HUD, 186
opening, 108
out-of-gamut alert, 188

Color profiles
assigning, 35
changing, 12
converting, 12
defined, 5
listing for documents, 21
mismatch, 10, 35
missing, 10, 35
removing, 12
using for soft proof, 448–449

Color Range command
accessing, 160
creating selections via, 160–161
Localized Color Clusters option, 162
Skin Tones option, 161

Color Reduction algorithms, 465
Color Replacement tool

defined, 101
Options bar, 290, 293
using, 290–291

Color Sampler tool (Camera Raw), 56
Color settings

installing, 11
options, choosing, 8
preset, choosing, 8
saving, 11
synchronizing, 9

Color Settings dialog
accessing, 8, 10, 11
in color policy customization, 10
color space selection in, 8
illustrated, 10
saving color settings in, 11
Settings menu, 457
Working Spaces area, 457

Color spaces
Adobe RGB, 5–6, 8
choosing, 8
defined, 5
Monitor RGB, 8

ProPhoto RGB, 8
setting, 6
sRGB, 8

Color Universal Design guidelines, 195
Color-blind viewer design, 195
Color(s)

Background, defined,185
blending modes, 191–192
as building blocks, 2
choosing, 185–186
choosing from color libraries, 187
choosing from Swatches panel, 189
choosing with Color Picker, 185, 

186–187
copying as hexadecimals, 190
desaturating, 220, 221
display consistency, 5, 7
document-specific, 10
fill layers, 193
filtering layers via, 146–147
Foreground, 185, 186
layers, assigning to, 145
picking up from images, 190
process, 186–187
profiles, 5, 10, 12
proofing, 448–449
rendering intents, 449, 452
replacing, 288–289
restoring, selectively, 221
sampling with Eyedropper tool, 190
selection via, 158–162
spot, 186, 187, 370
type, 359, 370
vector shape, 389

Commands (action)
adding, 402
adding modal controls to, 403
deleting, 404
duplicating within/between  

actions, 402
settings, changing, 404

Commercial printing
file preparation for, 449, 457
workflow for, 457

Comparative blending modes, 191
Component blending modes, 191
Contact Sheet II dialog, 416–417
Contact sheets

Contact Sheet II command, 416–417
defined, 416
PDF, via Bridge, 418–419
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Content panel (Bridge)
compact window display, 36
defined, 26
in folder display, 30
metadata display in, 37
search results, 45
thumbnail selection in, 30–31

Content-Aware fill, 305
Content-Aware healing, 297, 304
Content-Aware Move tool

defined, 101
moving/reshaping with, 306–307
Options bar, 306

Content-Aware patching, 308
Content-Aware Scale command, 

334–335
Context menus

Layers panel, 141
using, 100

Contrast
auto adjustment, 215
Brightness/Contrast adjustment, 212
Curves adjustment, 222–223
Levels adjustment, 210–211, 238
midtones, 232
Shadows/Highlights adjustment, 

230–232
Contrast adjustments (Camera Raw)

adjustments 62–64
edge, 65 

Contrast blending modes, 191
Convert to Profile dialog, 12
Converting

color profiles, 12
layer to Background, 138
layer to grayscale, 226–228
layers to Smart Objects, 248
RGB files to CMYK, 457
type, paragraph to point/point to 

paragraph, 360
vector shapes to pixels, 390

Copying
action commands, 402
imagery to new layer, 241
layer effects, 380
layer masks, 176
layer settings, 241
layer styles, 383
layers, 149, 244–247
pasting, 240, 242
selection borders, 155
selections, 240, 243–245

Smart Filters, 345
stroke and fill attributes on shapes, 

389–390
vector masks, 393

Create Custom Shape dialog, 388
Creative Suite applications, synchro-

nizing color settings in, 9
Crop box

cropping to, 130
editing with Crop tool, 129
repositioning images within, 128
resetting, 128
resizing, 127, 130
selection in defining, 131

Crop tool
Camera Raw, 56
crop box reset, 128
cropping image, 127
cropping multiple images, 130–132
cropping to aspect ratio, 130
cropping to crop box, 130
cropping to size and resolution, 130
defined, 101
enlarging canvas area, 132
overlay options, 128
preview options, 128
recording use of, 399
shield options, 128
sticky settings, 131
straightening images with, 133

Cropping
to aspect ratio, 130
with Crop and Straighten Photos 

command, 134
to crop box, 130
manually, 127
nondestructive, 128
to specific size and resolution, 130
trim areas, 132

.csf files, 11
Cursors preferences, 101, 297, 440
Curves adjustment layer

applying, 222–225
color correction with, 224
in darkening midtones, 204
options, 222–223
Targeted Adjustment tool, 222, 224
tonal adjustments with, 222–223
See also Adjustment layers

Curves Display Options dialog, 222
Custom Shape picker, 387, 388

Custom Shape tool
adding watermarks with, 410
creating vector masks with, 392
creating vector shapes with, 387–388
defined, 102

Customize Proof Condition dialog, 448
Cut paper type, 368

D
Darken blending modes, 191, 301
Define Custom Shape command, 388
Delete Workspace dialog, 97
Desaturation, 220–221
Detail tab (Camera Raw)

color noise reduction in, 68–69
illustrated, 59
luminance reduction in, 68–69
sharpening in, 68

DIC Color Guide, 187
Diffuse Glow filter, 349
Digimarc, 411
Dimensions

document, 121–125
pixel, changing, 124
selection, 152
Web, 13, 16

Direct Selection tool, 102
Displays, calibrating, 7, 201
Distortion

layer, 332–333
Liquify, 338–339
Puppet Warp, 336–337
tools, 338
Warp, 340
See also Transformations

Distributing layers, 261
Dither in GIF optimization, 465
DNG files (Camera Raw), 84
Docks, panel

collapsing, 94
creating, 95
hidden, displaying, 93
reconfiguring, 94–95

Document windows
context menus in, 100
displaying one image in two, 88
docking, 87
floating, 87
multiple, scrolling in, 91
multiple, zooming in, 91
repositioning images in, 90
resizing, 88
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selecting layers or layer groups, 246
status bar, 21
tiling, 88

Documents
blank, creating, 15–16
closing, 22
creating from history states, 184
creating from layers, 246
creating from thumbnails, 248
data, 21
dimensions, changing, 121–125
dragging files into, as Smart Objects, 

250–251
flattened, 150
opening as tabs, 87
presets, creating, 16
resolution, 121–125
reverting to last version, 18
saving, 18–20
size, listing, 21

Dodge tool, 102
Dodging, 233
Downloading photos (Bridge), 24–25
Drag-copying selections, 243, 244
Drawing

shapes for vector masks, 392
vector shapes, 387–388, 391

Drawings, transforming photos into, 
352–354

Drop Shadow layer effect
applying, 376–377
on brush strokes, 351
in rusted metal type, 384
transforming, 377

Droplets for actions, 400
Duplicate Layer dialog, 246
Duplicating

actions, 401
Background, 280, 423
layer comps, 422
layers and layer groups, 137
Smart Objects, 252
See also Copying

E
Edit menu

Assign Profile command, 12
Auto-Align Layers command, 

266–267
Clear command, 154, 242
Color Settings command, 8, 10, 11, 

289, 449, 457

Content-Aware Scale command, 
334, 335

Convert to Profile command, 12
Copy command, 240, 242
Copy Merged command, 240, 242
Cut command, 154, 240
Define Custom Shape command, 

116, 410
Define Pattern command, 116, 199
Fill command, 117, 199, 207, 305, 319
Free Transform command, 332, 333
Free Transform Path command, 332
Menus command, 96
New command, 242
Paste command, 240, 390
Paste Special command, 240, 242
Presets command, 118, 119
Puppet Warp command, 336–337
Purge command, 180, 240
Transform submenu

Distort command, 368, 377
Flip commands, 134
Perspective command, 368
Rotate commands, 134
Warp command, 340, 363

Edit menu (Bridge)
Creative Suite Color Settings 

command, 9
Develop Settings command, 82
Find command, 46

Edit Smart Collection dialog, 46
Editable type layers

creating, 356–357
defined, 112
fading, 362
merging, 148
rasterizing, 368
recoloring, 359
thumbnail icon, 357
See also Type

Effects tab (Camera Raw)
grain texture application, 76
vignette application, 77

Elliptical Marquee tool
in creating selections, 152
in creating vignettes, 405, 406
defined, 101
in deselection, 154
fixed ratio/dimensions selection, 152
in frame-shaped selections, 163
Options bar, 152, 405, 406

Embedded Profile Mismatch alert, 35

Emboss layer effect, 374–375
Embossed leather type, 386
Eraser tool

defined, 102
using, 282

Erodible Point tips, 275–276
Essentials workspace (Bridge), 28, 29
Every-Line Composer, 364
Export/Import Presets dialog, 118
Exporting

Bridge cache, 50
preset libraries, 118

Exposure correction (Camera Raw)
adjustments, 62–64
Basic tab, 256, 257

Exposures, combining, 256–258
Eyedropper tool

defined, 101
sampling colors with, 190

Eyes, whitening, 292

F
Favorites panel (Bridge), 26, 30
Field Blur filter

applying, 312
mask, using, 317
pins, 313, 316
selections with, 313
using, 313

File formats
layer support, 344
Photoshop feature preservation, 18
in saving files, 18–20, 460–463
Web, 463, 465–468

File Handling & Clipboard Preferences 
(Illustrator), 250

File Handling preferences, 437–438
File Compatibility, 437–438
File List, 438
File Saving Options, 437
illustrated, 438

File menu
Automate submenu

Contact Sheet II command, 416
Create Droplet command, 400
Crop and Straighten Photos 

command, 134
Browse in Bridge command, 9
Close command, 22
Exit command, 22
New command, 15, 16
New Dialog command, 136
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Open as Smart Object command, 249
Open command, 458
Open command (Bridge), 34
Open Recent File command (Bridge), 

34
Place command, 251, 458, 459
Print command, 450
Revert command, 18, 179
Save As command, 12, 18, 20, 150, 

457, 459
Save command, 18
Save command (Camera Raw), 84
Save for Web command, 464, 465, 467
Scripts submenu, 381

File menu (Bridge)
New Window command, 28
Open Recent command, 34

File Type Associations preferences 
(Bridge), 446

Files
commercial printing, 457
dragging into documents as Smart 

Objects, 250–251
getting into Illustrator, 458–459
getting into InDesign, 458, 459
importing multiple as Photoshop 

layers, 248
opening as Smart Object, 249
opening from Camera Raw as Smart 

Object, 249
optimized, 464–468
pasting into Photoshop as Smart 

Objects, 250–251
placing into Photoshop as Smart 

Objects, 250–251
resampling, 121
resolution, calculating, 13–14
resolution, changing, 121–125
saving for the Web, 463
saving in PDF format, 460
16-bit, 32-bit, 17
size, 20
versions, saving, 20
video, 426
ZIP, 462

Files (Bridge)
assigning keywords to, 38–39
batch-renaming, 44
cache, 50
copying, 43
deleting, 43
managing, 38–39

moving, 43
opening, 34–35
opening from Mini Bridge, 49
previewing, 48
renaming, 43
reopening, 34
searching, 45
searching via Mini Bridge, 49

Files (Camera Raw)
advantages to using, 51–53
copy, opening, 84
JPEG files versus, 51, 53
opening into Photoshop, 84
previewing, 52
saving, 84
TIFF files versus, 51, 53

Fill dialog, 199, 305
Fill layers

blending mode, 193–195
color, changing, 193
defined, 112
Gradient, 194
opacity, 193–195
Pattern, 195
Solid Color, 193

Filmstrip workspace (Bridge), 28
Filter Gallery

accessing, 342, 344
Delete Effect Layer button, 342
dialog illustration, 343
New Effect Layer button, 342
previews, hiding/showing, 342
using, 342–343

Filter masks
creating, 346
deactivating, 346
deleting, 346
editing, 346–348
gradient, 348
wiping clean, 348

Filter menu
Blur submenu

Field Blur filter, 312
Gaussian Blur filter, 300
Iris Blur filter, 312
Lens Blur filter, 310
Motion Blur filter, 320
Surface Blur filter, 299
Tilt-Shift filter, 312

Brush Strokes submenu, 385
Convert for Smart Filters  

command, 344

Filter Gallery, 342–343
Lens Correction filter, 318, 407
Liquify filter, 338
Oil Paint filter, 352–353
Other submenu, Minimum filter, 350
Sharpen submenu

Smart Sharpen filter, 322
Unsharp Mask filter, 325

Stylize submenu, Find Edges filter, 
350, 354

Filter panel (Bridge)
defined, 26
filtering thumbnail display, 41

Filters
adjustment layers and, 349–350, 353
applying, 341–343
applying as Smart Filter, 344
applying via Filter Gallery, 342–343
blending modes and, 350
brush strokes and, 351
Diffuse Glow, 349
effects, hiding, 342
effects, stacking position, 342
Field Blur, 312, 313, 317
Find Edges, 350
Foreground/Background colors, 342
Gaussian Blur, 300–301
Iris Blur, 312, 314, 317
last used, reopening, 342
Lens Blur, 309–311
Lens Correction, 133, 318–319, 407
Liquify, 297, 338–339
memory problems and, 346
Minimum, 350
Motion Blur, 320–321
Oil Paint, 352–353
Palette Knife, 353
preview feature, 343
reapplying, 342
Smart Sharpen, 322–324
Spatter, 385
Surface Blur, 299
Texturizer, 351
Tilt-Shift, 312, 315, 317
tips for using, 346
unavailable, 341
Unsharp Mask, 325–326
uses, 341
video clip application to, 431

Find dialog (Bridge), 45
Find Edges filter, 350
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Flattening
layer effects, 381
layers, 150

Flipping
clone source overlay, 263
layers, 134

FOCOLTONE colors, 187
Folders (Bridge)

adding to Favorites panel, 30
copying, 43
creating, 43
deleting, 43
moving, 43
navigating to, 30
renaming, 43

Folders panel (Bridge), 26, 30
Fonts

family, changing, 359
missing fonts alert, 35
size, changing, 360
style, changing, 359
vector outlines, 357

Foreground color
choosing, 185, 186–190
filters that use, 342

Full Screen Mode, 92

G
Gaussian Blur filter, 300–301
General preferences, 434–435

Export Clipboard, 239–240, 434
History Log, 435
HUD Color Picker option, 186, 434
illustrated, 435
Image interpolation option, 434
Place or Drag Raster Images as Smart 

Objects, 250, 434
Resize Image During Place, 250, 434
Snap Vector Tools and Transforms to 

Pixel Grid, 388, 434
Vary Round Brush Hardness Based on 

HUD Vertical Movement, 272, 434
General preferences (Bridge), 444
GIF format

optimizing file in, 465–466
preview options, 468
saving files in, 463

Gradient Editor dialog
illustrated, 197
opening, 196, 228
in tinting images, 228–229

Gradient Fill dialog, 117, 194, 197

Gradient fill layers
applying gradients via, 197
creating, 194–195
settings, editing, 195

Gradient Map adjustments, 228–229
Gradient Overlay layer effect, 378–379
Gradient tool

applying gradients via, 198
defined, 102
editing layer mask via, 259–260
filter effect, 346, 348
Options bar, 198, 259, 309

Gradients
applying via fill layer, 194
creating, 116
defined, 194
effects, complex, 197
filter mask, 346, 348
Gradient Overlay effect, 378
layer mask, 259–260
loading, 194
presets, 196–197
repositioning, 379
saving, 117, 119
scaling, 379
vector shape, 389

Graduated Filter tool (Camera Raw), 
56, 78–79

Grayscale
channels, 4
converting images to, 226
converting layer to, 226–228

Grayscale mode, 4
Grid

illustrated, 270
preferences, 442
showing/hiding, 270

Guides, Grid & Slices preferences, 
268, 442

H
Hair, selection of, 166–169
Hand tool

Camera Raw, 56
defined, 103
in repositioning images, 90
temporary, 90

HDR (High Dynamic Range) images
Merge to HDR Pro command, 

234–236
processing in Camera Raw, 237
producing, 234–237

shooting photos for composite, 234
HDR Toning command, 237
Healing Brush tool

defined, 101
hot spot removal, 295
Options bar, 294
using, 294–296
wrinkles, softening, 294, 295

Highlights
Color Balance adjustment, 217
Curves adjustment, 222–223
Levels adjustment, 210
lightening, 223
Shadows/Highlights command, 232

Histogram panel
Channel menu, 109
illustrated, 109
interpreting graph in, 209
updating, 208
using, 208–209
views, choosing, 208

History Brush tool
defined, 102
History panel with, 109
Options bar, 283–284
using, 283–284

History Options dialog, 178, 181
History panel

defined, 177
Delete Current State button, 180
History Brush tool with, 109
History States preference, 178, 439
illustrated, 109
linear mode, 177, 178, 179
log, 435
New Document from Current State 

button, 184
New Snapshot option, 182
nonlinear mode, 178, 179
options, 177–178

History states
changing, 179
clearing or purging, 180
deleting, 109, 180
document creation from, 184
History Brush tool to restore areas 

from, 283–284
number of, 178
restacking, 179
snapshots, 180–183

HKS colors, 187
Horizontal Type Mask tool, 102
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Horizontal Type tool
defined, 102
creating type with, 355–357
Options bar, 356, 360
recoloring type with, 359
restyling type with, 359–360
selecting type with, 358

HSB model, 188
HSL/Grayscale tab (Camera Raw), 59, 

70–71
HUD color picker, 186
Hue/Saturation adjustments

applying, 218
for increasing saturation, 205
range, setting, 219
Targeted Adjustment tool, 218

I
Illustrator, Adobe

art, dragging, pasting or placing into 
Photoshop, 250–251

art, opening into Photoshop, 249
opening or placing Photoshop Layer 

into, 459
pasting shapes from, 390
Photoshop to, 458

Image menu
Adjustments submenu, 202

HDR Toning command, 237
Match Color command, 286
Replace Color command, 288
Shadows/Highlights 

command, 230
Canvas Size command, 126
Image Rotation commands, 91, 134
Image Size command, 122–125
Trim command, 132

Image Processor dialog, 462
Image Size dialog

image resizing (high res/small 
dimensions), 123

image resizing (medium res/small 
dimensions), 124

photo resolution, changing for print 
output, 122

pixel dimensions for Web output, 124
settings, restoring, 122

Images
color as building block of, 2
cropping, 127–131
flipping, 134
HDR, 234–237
for layer effects, 373

maximum size, 13
multichannel, 4
multiple, cropping, 130–132
PDF presentation of, 420–421
picking up colors from, 279
pixel dimensions, changing for Web 

output, 124, 466, 468
playing actions on, 397, 398–399
previews (Bridge), 30–33
print resolution, 14
protecting via copyright, 410–411
repositioning in document 

window, 90
reshaping areas in, 297, 336–339
resizing, 121–125
resizing (Camera Raw), 58
rotating, 134
straightening, 133
watermarks, 410–411
Web resolution, 13, 463

Importing
preset libraries, 118
type as Smart Object, 357
video files, 426

InDesign, Adobe
 Photoshop to, 458–459
placing Photoshop layer into, 459

Indexed Color mode, 4
Info panel, 110
Inkjet printing

outputting files for, 450–456
printer driver settings for, 450–451
RGB Color mode for, 447

Inner Glow layer effect, 384
Inner Shadow layer effect, 376, 384
Insert Menu Item dialog, 402
Interface preferences, 87, 92, 100, 

436–437
Appearance, 436
Options, 436
Text, 436

Inverting selections, 159
Iris Blur filter

applying, 312
mask, using, 317
selections with, 313
using, 314

J
JPEG files

importing into Photoshop as Smart 
Objects, 249–251

opening (Bridge), 34
opening into Camera Raw, 55
optimizing for Web, 467–468
preferences for opening into Camera 

Raw, 54
preview options, 468
raw files versus (Camera Raw), 51, 53
resolution of, 122
saving, 462
saving raw files as (Camera Raw), 84
for Web, 463

K
Kerning, 361
Keyframes, 425, 431
Keyword preferences (Bridge), 446
Keywords (Bridge), 38–39
Keywords panel (Bridge)

assigning keywords in, 39
creating keywords in, 38
defined, 26
using, 39

Kuler panel, 111

L
Lab Color mode, 4
Labels preferences (Bridge), 446
Lasso tool

defined, 101
in deselection, 154
in free-form selections, 153

Launching
Bridge, 23
Bridge from Mini Bridge, 48
Photoshop, 1

Layer Comp Options dialog, 422
Layer comps

alert icons, clearing, 423
creating, 111, 422
defined, 111
deleting, 424
displaying, 422–423
duplicating, 422
PDF presentation of, 424
updating, 423

Layer Comps Options dialog, 111
Layer Comps panel

Delete Layer Comp button, 424
illustrated, 111
Last Document State listing, 423
New Layer Comp button, 422
Restore Last Document State 

command, 423



478  Index

Update Layer Comp button, 423
Layer Comps to PDF dialog, 424
Layer effects

applying, 371–372, 373
applying to adjustment layer, 367
Bevel, 374–375
copying, 380
default settings, 373
Drop Shadow, 376–377, 384
Emboss, 374–375
essentials, 371–373
flattening, 381
Gradient Overlay, 378–379
hiding/showing, 372
imagery choices for, 373
Inner Glow, 384
Inner Shadow, 376, 384
live aspect of, 380
moving between layers, 380
Outer Glow, 384, 386
Pattern Overlay, 379
Pillow Emboss, 375
rasterizing, 381
removing, 380
Satin, 379
scaling, 379
settings, changing, 372
settings, saving, 375
Stroke, 378
types of, 371

Layer groups
in clipping mask, 328
creating, 140–141
deleting, 142
dragging up/down, 140
duplicating, 137
hiding/showing, 300
locking, 145
moving layers out of, 141
opacity, changing, 144
renaming, 138
selecting, 139, 246
ungrouping, 142

Layer masks
adding via Layers panel, 172
adding via Refine Edge dialog, 165, 

168, 172
applying, 176
black versus white areas in, 172, 173
blending exposures via, 258
color, changing, 173

copying, 176
creating, 172
defined, 172
deleting, 176
density adjustment, 174
disabling, 176
edges, refining, 175
editing, 173–175
editing on adjustment layers, 207
editing with Brush tool, 173, 260
enabling, 176
feather adjustment, 174
gradients in, 259–260
loading, 176
moving, 176
repositioning, 175, 405
reshaping, 173
shortcuts, 207
swapping black/white areas in, 173
working with, 175–176

Layer Style dialog
Angle setting, 372
Bevel & Emboss, 374–375, 386
Blending Options, 330–331
Contour presets, 372
Drop Shadow, 376–377, 381
Gradient Overlay, 378–379
illustrated, 372
Inner Shadow, 376
for layer styles, 382
opening, 330, 371, 373
Outer Glow, 384, 386
Pattern Overlay, 379
Stroke, 378

Layer styles
applying, 382
copying, 383
creating, 383
with Layer Styles dialog, 382
rasterizing, 381
removing, 382
saving, 383

Layers
aligning, with one another, 261
aligning, with Smart Guides, 143
blank, adding, 136
blending modes, 191–192, 329–331
clipping masks, 327–328
color-coding, 145
content, repositioning, 175
converting to Smart Object, 248

copying and merging, 149
creating, 136–138
deleting, 142
desaturating, 220, 221
distributing, 261
document creation from, 246
drag-copying, between files (Layers 

panel), 246–247
drag-copying between files (Move 

tool), 244–245
duplicating, 137
edges, fading via gradient in layer 

mask, 259–260
editable type, 112, 356–357
file formats supporting, 18, 344
file size and, 150
fill layers, 193–195
Fill percentage, 381
filtering, 146–147
flattening, 150
flipping, 134
Gradient fill, 194–195
hiding, 135, 142
into Illustrator, 459
image, defined, 112
into InDesign, 459
locking, 145
locking transparent pixels, 144
merging, 148–149
moving out of groups, 141
multiple, selecting, 139
naming, 137
nontransparent areas, selecting, 151
nudging one pixel at a time, 143
opacity, changing, 144
renaming, 136, 138
repositioning, 143
restacking, 140
rotating, 134
scaling, 246
screening back, 238
selecting, 139, 151
selecting, in document window, 246
shape, 112, 387–391
showing, 142
Solid Color fill, 193
straightening, 133
vector, 387–391
visible, merging, 149
warp edits, 340
See also Adjustment layers
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Layers panel
Add Layer Mask button, 258, 259, 

266–267, 299, 309, 354, 405
Add Layer Style menu, 371
Add Vector Mask button, 393
Advanced Blending badge, 331
Apply Layer Mask option, 176
Background, 135, 138
blending modes, 192, 329
Blending Options, 345
context menus, 141
Convert to Smart Object via, 248
Create Fill/Adjustment Layer menu, 

193, 194, 202
Delete Layer button, 206, 380, 394
Delete Layer Mask option, 176
Delete Vector Mask command, 394
Disable/Enable Mask button, 393
display options, 145
drag-copying layers via, 246–247
Duplicate Layer command, 149
Fill setting, 381
Filter buttons, 146–147
Flatten Image command, 150
illustrated, 112
Layer Filtering On/Off button, 146
layer mask creation via, 172
listings, filtering, 146–147
Lock Transparent Pixels button, 144, 

272, 284
Merge Down command, 206
Merge Visible command, 149
New Group button, 140
New Group from Layers command, 

140
New Layer button, 136, 137, 233
options, 145
Select Pixels command, 151
selecting layers via, 139
thumbnail options, 145
uses, 112
Video Group listing on, 426

Leading, 361
Lens Blur filter

accessing, 310
applying, 309–311
dialog illustration, 310
Iris area, 310–311
Specular Highlights area, 311

Lens Correction filter
applying, 318–319
Auto Correction tab, 318

Custom tab, 319, 407
vignette creation via, 407

Levels adjustment layer
illustrated effects, 210
mask, 367
screening back layers with, 238
settings, applying, 210
tonal values correction with, 210–211
See also Adjustment layers

Light Table workspace (Bridge), 28, 29
Lighten blending modes, 191, 300
Line tool, 102
Liquify filter

distortion tools, 338
edits, removing, 339
protecting image areas from, 339
Reconstruct Options, 339

Locking
layers or layer groups, 145
transparent pixels, 144

Loupe (Bridge), 32
Luminance (Camera Raw), 68–69

M
Mac OS

Application frame, 86
color management, turning off for 

printing in, 456
droplet usability in, 400
launching Bridge in, 23
launching Photoshop in, 1
quitting Photoshop in, 22
Save As dialog, 19
ZIP file creation, 462

Magic Eraser tool, 102
Magic Wand tool

defined, 101
Options bar, 158
using, 158–159

Masks
clipping, 327–328
creating, 172
density, 174
edges, softening, 406
editing, 173
fading edges of layer via, 259–260
feathering, 174
layers, 172–176
options on Properties panel, 114, 

174–175
partial, 170
refining edges of, 175, 245

storing selections as, 171
vignette creation via, 406
See also Filter masks, Layer masks, 

Quick Masks, Vector masks
Match Color dialog, 286–287
Merge to HDR Pro dialog

Advanced tab, 234, 235
Curves tab, 236
in making images look surreal, 237
opening, 234
Tones and Detail, 234, 235
using, 234–236

Merging
adjustment layers, 206
layers, 148–149
visible layers, 149

Metadata (Bridge)
displaying in Content panel, 37
in tool tips, 37

Metadata panel (Bridge)
defined, 26
keyword assignment via, 39

Metadata placard (Bridge), 30
Metadata preferences (Bridge), 445
Midtones

adjusting separately, 331
Color Balance adjustment, 217
color value selection, 214
contrast, 232
darkening, 203, 204
with Levels adjustment, 210
lightening, 223, 238
range, controlling, 230
reducing blue and green in, 225

Mini Bridge panel
accessing, 48
defined, 48
docking/floating, 49
file searches via, 49
illustrated, 49
Image Processor command, 462
loading image files into layers via, 248
opening image files from, 34, 49
opening video files from, 426
previewing files in, 48

Minimum filter, 350
Missing Profile alert dialog, 35
Mixer Brush tool

Airbrush tip, 276
bristle brush creation, 278
bristle brush paint options, 279
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cleaning bristle brushes, 279
defined, 101
Erodible tips, 276
Options bar, 278, 279, 280
photos into paintings, 280–282, 

351–353
using, 278–282

Monitor RGB color space, 8
Motion Blur filter, 320–321
Motion panel for video, 429
Motion workspace, 425
Move tool

drag-copying with, 243, 244–245
in layer selection, 139
in moving selection contents, 155
Options bar, 241, 246, 261
in repositioning layer mask, 175
scaling type with, 360
transformations with, 332–333

Moving
with Content-Aware Move tool, 306
layer effects, 380
layer masks, 176
selection borders, 155
selection contents, 155
vector masks, 394

N
Navigator panel

illustrated, 113
repositioning image in window via, 90
zooming in or out via, 90

New (document) dialog, 15–16
New Actions dialog, 396
New Crop Preset dialog, 131
New Document Preset dialog, 16
New Layer Comp dialog, 422
New Layer dialog, 138
New Preset dialog (Camera Raw), 81
New Snapshot dialog, 182
New Spot Channel dialog, 370
New Style dialog, 383
New Tool Preset dialog, 120
New Workspace dialog, 38, 96
Noise reduction (Camera Raw), 52
North America Prepress 2 option, 8, 10

O
Oil Paint filter, 352–353
Opacity

blending layers via, 329
brush, 271, 272

changing, layer or layer group, 144
duplicate layer, 354
fill layer, 193–195
overlay, 378, 379
shadow, 376
Smart Object, 347
stops in gradients, 196–197
tool, 191

Open as Smart Object dialog, 249
OpenGL, enabling, 85, 439
OpenType characters, 363
Optimized files

format choices for, 463
in GIF format, 465–466
in JPEG format, 467–468
preset, creating, 468
previewing, 464

Options bar
accessing, 98
Brush tool, 170, 173, 207, 233, 

271–272
Character panel, 359
Clone Source tool, 262
Clone Stamp tool, 302–303
Color Replacement tool, 290, 293
Content-Aware Move tool, 306
Content-Aware Scale command, 334
Crop tool, 127, 128, 132
Elliptical Marquee tool, 152, 405, 406
Eraser tool, 282
Eyedropper tool, 190
features, 98
Free Transform command, 333
Gradient tool, 198, 259, 309
Healing Brush tool, 294
History Brush tool, 283–284
Horizontal Type tool, 356, 359, 360
illustrated, 98
Magic Wand tool, 158
Mixer Brush tool, 278, 279, 280
Move tool, 139, 241, 246, 261
Patch tool, 298, 308
Path Selection tool, 389, 390, 393
Puppet Warp command, 336
Quick Selection tool, 156
Rectangular Marquee tool, 152
Red Eye tool, 293
Ruler tool, 270
shape tools, 388, 391, 392
Sharpen tool, 321
Spot Healing Brush tool, 297
Toggle Brush Panel button, 95

values, canceling, 98
Vertical Type tool, 356, 359, 360
Warp command, 340
Workspace menu, 92, 96, 97, 98

Orientation, type, 362
Outer Glow layer effect, 384, 386
Out-of-gamut alert, 188
Output panel (Bridge), 

PDF contact sheet via, 418–419
PDF presentation via, 420–421
Web Gallery creation, 412–416

Output preferences (Bridge), 446
Overlay blending mode, 233

P
Paintings

oil, turning photos into, 352–353
turning photos into, 280–282, 

351–353
Palette Knife filter, 353
Panel

Actions, 104, 395–404
Adjustments, 105, 201–206
Brush, 105, 273–276
Brush Presets, 106, 277
Channels, 2–4, 106
Character, 107, 355, 357, 361–363
Character Styles, 107, 364
Clone Source, 108, 262–263
Color, 108, 188
Histogram, 109, 208–209
History, 109, 177–184
Info, 110
Kuler, 111
Layer Comps, 111, 422–424
Layers, 112, 135–151, 246–248, 

258–259, 266–267
Mini Bridge, 48–49
Navigator, 90, 113
Paragraph, 113, 357, 364
Paragraph Styles, 113, 364
Properties, 114, 173, 176, 202–206
Styles, 115, 382–383
Swatches, 115, 189
Timeline, 115, 425–432
Tool Presets, 115, 120
Tools, 101–104, 170

Panel groups
closing, 94
floating, 95
maximizing/minimizing, 94
moving, 95
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reconfiguring, 94–95
Panels

closing, 94
configuring, 93–95
deleting presets from, 116
hidden docks, displaying, 93
hiding, 93, 94
icons, 100
maximizing/minimizing, 94
moving, 95
opening, 93
preset management via, 116–118
redocking into Application frame, 95
restoring default presets to, 118
showing, 93, 94
widening or narrowing, 95

Panels (Bridge)
Collections, 26
configuring manually, 36
Content, 26, 36, 37
displaying/hiding, 36
Favorites, 26, 30, 45
Filter, 26, 41
Folders, 26, 30
Keywords, 26, 38–39
Metadata, 26, 39
Preview, 26, 30

Panoramas, 264–265
PANTONE PLUS colors, 187
Paragraph panel

alignment buttons, 364
controls, 364
East Asian Features, 357
functions, 113
hyphenation option, 364
illustrated, 113
justification buttons, 364
Middle Eastern Features, 357

Paragraph Styles panel
Clear Overrides button, 365
functions, 113
illustrated, 113
New Paragraph Style button, 365
Refine Style command, 365

Paragraph type
converting to or from point type, 360
creating, 356
transforming, 366

Paste Camera Raw Settings dialog, 82
Paste dialog, 250

Pasting
Illustrator art into Photoshop, 250
selections, 240
into selections, 242
shapes from Illustrator, 390

Patch tool
defined, 101
Options bar, 298, 308
removing image elements with, 308
retouching with, 298

Path Selection tool
defined, 102
Options bar, 389, 390, 393
in repositioning vector mask, 393
in switching function of vector 

masks, 394
Pattern fill layers, 195
Pattern Overlay layer effect, 379
Pattern picker, 199, 275
Patterns

custom, 199–200
in Bevel & Emboss effect, 375
Fill dialog, 199
in fill layers, 199
illustrated, 200
Pattern Overlay effect, 379
scripted, 199–200
on vector shapes, 389

PDF format
contact sheets, 418–419
Photoshop feature preservation in, 18
presentation of images, 420–421
presentation of layer comps, 424
saving files in, 460, 462

Pen tool, 102
Performance preferences, 439

Graphics Processor Settings, 85, 439
History & Cache, 178
Memory Usage, 439
Scratch Disks, 439

Perspective
correction, 318–319
transformation, 333

Perspective Crop tool, 101, 131
Photo Downloader (Bridge), 24–25
Photo Filter adjustments, 213
Photomerge dialog, 264–265
Photos

downloading (Bridge), 24–25
sampling colors from, 280
shooting for panorama, 264

turning into oil painting, 352–353
turning into paintings, 280–282
turning into tinted drawing, 354

Photos (Camera Raw)
archiving as DNG files, 84
cropping, 57
grayscale, color tint application to, 75
opening, 54
preferences, setting, 54
sharpening, 68
Smart Object editing, 254
straightening, 57
updating, 54

Photoshop
exiting/quitting, 22
getting to quickly, 34
launching, 1
new or improved features identified, 1

Photoshop Import Options dialog, 459
Pickers

deleting presets from, 116
preset management from, 116–118
restoring default presets to, 118
saving presets on, 117
See also specific Pickers

Pillow Emboss layer effect, 375
Pixels

adding to canvas, 126
converting vector shapes to, 390
dimensions, changing for Web 

output, 124
distribution on Histogram panel, 209
erasing, 282
hidden, displaying, 241
maximum image size in, 13
outside canvas, 241
pasted, 240
rasterizing type into, 368–369
selection, turning into layer, 137
transparent, locking, 144

Place dialog, 255, 458
Playback preferences (Bridge), 445
Plug-ins preferences, 442–443
Point type

converting to paragraph type, 360
creating, 356

Polygon tool, 102
Polygonal Lasso tool

defined, 101
in straight-sided selections, 153

Pop-up sliders, 107
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PostScript printing options, 454
Preferences, 434–443

Cursors, 101, 297, 440
File Handling, 20, 54, 437–438
General, 239–240, 272, 434–435
Guides, Grid & Slices, 268, 442
Interface, 92, 100, 436–437
opening, 433
Performance, 85, 178, 439
Plug-ins, 442–443
resetting, 433
Transparency & Gamut, 144, 440
Type, 357, 443
Units & Rulers, 16, 441

Preferences (Bridge), 444–446
Advanced, 446
Cache, 50, 446
Camera Raw, 54
File Type Associations, 446
General, 30, 54, 444
Interface, 87
Keywords, 446
Labels, 40, 446
Metadata, 445
opening, 433
Output, 446
Playback, 445
resetting, 433
Startup Scripts, 446
Thumbnails, 37, 445

Preferences (Camera Raw), 54
Preset libraries

exporting, 118
importing, 118
loading, 117, 119
saving presets as, 117, 119

Preset Manager
illustrated, 119
loading presets via, 119
opening, 119, 277
saving presets via, 119

Presets
adjustment layer, 206
brush, 277
creation of, 116
default, restoring, 118
deleting, 16, 116, 119
document, 16
exporting and importing, 118
gradient, 196
loading 117, 119

optimization, 468
renaming, 119
saving, 16, 117, 119
tools, 120
unsaved, storage, 116
Web Gallery settings as preset, 415

Presets (Camera Raw)
applying, 81
saving settings as, 81

Preview panel (Bridge)
defined, 26
image display in, 30, 32

Preview workspace (Bridge), 28, 29
Previews

Camera Raw, 59
filter, 342, 343
GIF/JPEG optimization options, 468
optimized file, 464

Previews (Bridge), 30–33
comparing, 32
full-screen, 32
quality options, 31
in Review mode, 33
thumbnails, 30

Previews (Camera Raw)
histogram clipping warnings, 62, 63
Threshold, 64
toggling, 59
zooming in, 56

Print dialog
accessing, 450
Color Management settings, 452, 

455, 456
illustrated, 453
PostScript Options category, 454
printer driver settings, 450–451
Printing Marks options, 454
settings, 452–454

Print output
commercial, 449, 457
file resolution, 14, 16
file resolution (Camera Raw), 58 
quasi hard proof, 454
resolution, changing, 121–125
scaling, 452

Printers
color management, turning off, 

455–456
driver settings, 450–451
profiles, acquiring, 11
rendering intents and, 449

Process colors, 187

Profiles
color, 5, 12, 35
document listing, 21
printer, 11

Proofing colors
on an inkjet printer, 454
soft, for commercial printing, 449
soft, for inkjet output, 448
soft, for Web output, 449

Properties panel
adjustment layer options, 114
Apply Mask button, 176
Auto-Select Parameter option, 205
Black & White controls, 226, 227, 228
Brightness/Contrast controls, 212
Clip to Layer button, 205
Color Balance settings, 216, 217
Curves Display Options, 222
Delete Adjustment Layer button, 206
Delete Mask button, 176
Gradient Map controls, 228, 229
Hue/Saturation controls, 218, 292
illustrated, 114
Invert button, 173
Levels controls, 210, 238
Load Selection from Mask button, 176
Mask Edge option, 175
mask options, 114
Photo Filter controls, 213
settings

choosing, 202–205
editing, 204
restoring, 204
saving as preset, 206
viewing image without 

current, 204
Vibrance controls, 219, 220

Properties/Print dialog, 450, 451
ProPhoto RGB color space, 8
PSB files, 18
PSD format

in feature preservation, 18
image files, 1
saving files in, 462
saving raw files in, 84

Puppet Warp command, 336–337

Q
Quick Mask Options dialog, 171
Quick Masks

painting with, 171
in reshaping selections, 170
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using, 170
Quick Selection tool

cleaning up with, 157
defined, 101
Options bar, 156
using, 156–157

R
RAM, 21
Rasterizing

layer effects and styles, 381
Smart Objects, 255
type, 368–369

Raw files (Camera Raw)
advantages to using, 51–53
conversion, 58
copy, opening, 84
JPEG files versus, 51, 53
opening into Camera Raw, 54–55
opening into Photoshop, 84
previewing, 52
saving, 84
TIFF files versus, 51, 53
See also Camera Raw

Record Stop dialog, 401
Rectangular Marquee tool

in creating selections, 152
defined, 101
in deselection, 154
fixed ratio/dimensions selection, 152
in frame-shaped selections, 163
Options bar, 152

Red-eye removal, 293
Red Eye Removal tool (Camera Raw), 56
Red Eye tool

defined, 101
using, 293

Refine Edge dialog
accessing, 165
in artistic border creation, 408
Decontaminate Colors, 168, 169
illustrated, 165
layer mask creation with, 172, 245
Output To menu, 408
Refine Radius tool, 168
refining hair selection with, 166–169
refining selection edges with, 165, 245
Smart Radius option, 166

Refine Mask dialog, 175
Refocusing. See Blur filters
Render Video dialog, 432
Rendering intents, 449, 452

Replace Color dialog, 288–289
Resampling files, 121–125
Reshaping

bounding box, 366
with Content-Aware Move tool, 306
images, 297
layer masks, 173
with Liquify filter, 338-339
with Puppet Warp command, 

336–337
selections, 170
shadows, 377
with Warp command, 340

Resolution
calculating, 13–14
default values, setting, 16
defined, 121
document, 121–125
document dimensions compared 

to, 125
image, 123–124
print output, 14, 16, 58, 122
selecting, 15
Web output, 13, 16, 463

Retouching
by cloning imagery, 302–303
Color Replacement tool, 290–291
eye whitening, 292
Gaussian Blur filter, 300–301
guidelines, 285
Healing Brush tool, 294–296
Match Color command, 286–287
Patch tool, 298, 308
Red Eye tool, 293
Replace Color command, 288–289
skin smoothing, 299
Spot Healing Brush tool, 297, 304
Surface Blur filter, 299
teeth whitening, 292

Review mode (Bridge)
previewing images in, 33
rating thumbnails in, 40

RGB Color mode
channels, 3
conversion, 3, 4
defined, 3, 4
for inkjet printing, 447
for Photoshop work, 201

RGB model
choosing, 188
in color selection, 186
defined, 2, 188

Rotate View tool, 91, 103
Rotating

bounding box, 366
clone source overlay, 263
items, 333
layers, 134
via Puppet Warp command, 336, 337

Rounded Rectangle tool, 102
Ruler guides

creating at specific location, 270
creating by dragging, 269
locking/unlocking, 270
removing, 270

Ruler tool
defined, 101
in measuring distance/angle via, 270
Options bar, 270
straightening layers with, 133

Rulers
origin, changing, 269
showing and hiding, 269
units, changing, 269, 441
units, in actions, 396

Rusted metal type, 384–385

S
Satin layer effect, 379
Saturation adjustments

Basic tab (Camera Raw), 65
Color Replacement tool, 290–291
Hue/Saturation, 205, 218–219
vibrance, 219–221
in whitening teeth, 292

Save Adobe PDF dialog, 460
Save As dialog, 18, 19, 20, 150, 460, 461
Save for Web dialog

GIF format, 465–466
illustrated, 464
JPEG format, 467–468
previewing optimization settings, 464

Save Options dialog (Camera Raw), 84
Save Settings dialog (Camera Raw), 81
Saving

action sets, 404
adjustment presets, 206
blur masks, 312
brushes, 277
Camera Raw settings, 81
color settings, 11
custom workspaces, 96
document presets, 16
documents, 18–20
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flattened documents, 150
in JPEG format, 462
layer effect settings, 383
multiple files, 462
in PDF format, 460, 462
presets, 117, 119
in PSD format, 18–19, 462
selections, 164
Shadows/Highlights settings, 232
styles, 383
in TIFF format, 461, 462
for Web, 463–468
Web Gallery settings as preset, 415
workspaces (Bridge), 38

Scaling
based on percentages, 334
clone source overlay, 263
Content-Aware, 334–335
gradients, 379
items, 332
layer effects, 379
layers, 246
patterns, 199, 375, 379
print output, 452
Smart Objects, 250, 251
styles, via Image Size dialog, 123
type, 360

Screen mode menu on Tools panel, 92
Screening back type, 367
Scripted patterns, 199–200
Scrolling in multiple windows, 91
Scrubby sliders, 107
Searching for files (Bridge), 45
Select menu

All command, 151
Color Range command, 160
Deselect command, 154
Deselect Layers command, 365
Grow command, 159
Inverse command, 159
Reselect command, 154
Similar command, 159
Transform Selection command, 332

Selection edges
adjusting, 241
feathering, 243
refining, 165–169

Selections
adding to via command, 159
in adjustment layers, 202
with blur filters, 313

border, moving, 155
border, showing/hiding, 162
of colors, 160–162
contents, moving, 155
Color Range command, 160–162
creating via Quick Mask, 171
creating via vector path tools, 164
deleting, 154
deselecting, 154
drag-copying, between files (Move 

tool), 244–245
drag-copying, on same layer, 243
editing via Quick Mask, 170
Elliptical Marquee tool, 152, 163, 

405–406
enlarging, 156
expanding, 159
filling, 154
frame-shaped, 163
free-form, 153
hair, 166–169
inverting, 159
Lasso tool, 153
layer-based, 151
loading alpha channels as, 164
loading layer masks as, 176
Magic Wand tool, 158–159
moving border of, 155
moving contents of, 155
nontransparent areas of layer, 151
pasting into, 242
Polygonal Lasso tool, 153
Quick Selection tool, 156–157
Rectangular Marquee tool, 152, 163
reselecting, 154
reshaping, 170
storing as a mask, 172
saving, 164
straight-sided, 153
type, 358
whole layer, 151

Settings menu (Camera Raw)
restoring settings via, 60
saving settings as presets via, 81

Shadow clipping (Camera Raw), 64
Shadows

auto correction, 214–215
Brightness/Contrast adjustment, 212
Color Balance adjustment, 216
Curves adjustment, 222–223
dodging and burning, 233
drop (layer effect), 376–377

in HDR images, 234–237
Levels adjustment, 210–211
pixels in histogram, 209
reducing, 231
in Shadows/Highlights command, 

230–232
softening, 323
tinting (Camera Raw), 75

Shadows/Highlights command, 
230–232

Shape layers. See also Vector shapes
creating vector masks from, 392
defined, 112
merging, 148
warp settings, 340

Shape picker, 410
Sharpen tool

defined, 102
using, 321

Sharpening
photos (Camera Raw), 68
Sharpen tool, 102, 321
Smart Sharpen filter, 322–324
Unsharp Mask filter, 325–326

Shortcuts
layer mask, 207
tool setting changes, 272
transform, 333
undo, 99
zoom, 89

Single Column Marquee tool, 101, 152
Single Row Marquee tool, 101, 152
Single-Line Composer, 364
16-bit files, 17
Skewing items, 333
Skin smoothing

with Gaussian Blur filter, 300–301
with Surface Blur filter, 299

Smart collections (Bridge), 47
Smart Filters

applying, 344
blending options, editing, 345
copying, 345
deleting, 346
editing, 344
example use, 347–348
hiding/showing effects, 345
mask, 346
restacking, 345

Smart Guides
aligning layer content with, 143
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in moving layers, 268
transformations with, 332

Smart Objects
applying filters to, 344–351, 353
converting layers to, 248
copies, converting to layer, 255
creating, 248–251
defined, 248
dragging files into documents as, 

250–251
duplicating, 252
editing, 253–254
importing type as, 250–251, 357
in lieu of merge or flatten, 148
linked duplicates, creating, 252
merging, 148
opacity, 347
opening files as, 249
opening files from Camera Raw as,  

249, 256–257
rasterizing, 255
replacing, 255
scaling, 251
thumbnails, 254

Smart Quotes, 357
Smart Sharpen filter, 322–324
Smudge tool, 102
Snap option, 269, 270
Snap To feature, 270
Snap Vector Tools and Transforms to 

Pixel Grid, 388
Snapshot tab (Camera Raw), 81
Snapshots (History panel)

creation of, 182
deleting, 183
of history state, 182
layer comps instead of, 423
as newest history state, 183
options, 181
using, 181–183

Soft proofs
commercial printing, 449
inkjet, 448
online output, 449

Solid Color fill layers, 166, 193
Spatter filter, 385
Special characters, inserting, 363
Split Toning tab (Camera Raw), 75
Splitting video clips, 428
Sponge tool, 102

Spot colors
channel, putting type in, 370
choosing, 187
for color accuracy, 186
defined, 186
separation into process colors, 187

Spot Healing Brush tool
Content-Aware option, 297, 304
defined, 101
Options bar, 297
using, 297

Spot Removal tool (Camera Raw), 56, 80
sRGB color space, 8
Startup Scripts preferences (Bridge), 

446
Status bar, 21
Straighten tool (Camera Raw), 56
Straightening

Crop and Straighten Photos 
command, 134

images, 133
layers, 133

Stroke layer effect, 378
Stroke on vector shapes

copying, 390
recoloring, 389
styling, changing, 390

Styles, layer
applying, 382
creating, 383
rasterizing, 381
removing, 382
saving, 117, 119
scaling, 123

Styles panel
Clear Style button, 382
illustrated, 115
New Style button, 383, 410
saving styles to, 383
uses, 115

Styles, type, 365
Suite Color Settings dialog, 9
Surface Blur filter, 299
Swatches, color

creating, 189
current, using, 189
default, restoring, 189
saving, 117, 119

Swatches panel
adding to, 189
choosing colors via, 189

illustrated, 115
New Swatch of Foreground Color 

button, 116, 189
saving swatches via, 117

Synchronizing
Camera Raw settings, 83
color settings, 9

T
Targeted Adjustment tool (TAT)

auto-selecting, 226
Black & White adjustment layer, 226
Curves adjustment layer, 222, 224
Hue/Saturation adjustment, 218

Targeted Adjustment tool (Camera 
Raw), 66, 71

Teeth whitening, 292
Textures, grain (Camera Raw), 76
Texturizer filter, 351
Thumbnail preferences (Bridge), 445
Thumbnails (Bridge)

adding to collection, 47
adding to stacks, 43
badge, 54
cycling through, 30
displaying, 30, 48
filtering, 41, 48
full-screen preview of, 32
grouping into stacks, 42
labeling, 33, 40
multiple, selecting, 30, 31
quality options, 31
rating, 33, 40
rearranging, 41
rearranging within stacks, 42
removing from collection, 47
removing from stacks, 43
removing ratings/labels from, 40
resizing, 36
selecting, 30
selecting in stacks, 42
sorting (Mini Bridge), 48
sorting order, choosing, 41
stacks, ungrouping, 43

TIFF files
in feature preservation, 18
opening (Bridge), 34
opening in Camera Raw, 54
raw files versus (Camera Raw), 51, 53
saving, 461
saving multiple files as, 462
saving raw files as (Camera Raw), 84
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TIFF Options dialog, 461
Tilt-Shift filter

applying, 312
mask, using, 317
in photography, 315
selections with, 313
using, 315

Timeline
adding tracks to, 426
defined, 425

Timeline panel
Add Keyframe button, 431
Add Media menu, 426, 429
Add Media to Track button, 426
Audio panel access, 432
Enable Keyframe Animation button, 

431
illustrated, 115, 425
Motion panel access, 429
Mute Audio Playback button, 427
New Video Group option, 426
opening, 425
Play button, 427
Render Video button, 432
Split at Playhead button, 428
Transition button, 428
uses, 115
in video editing, 425
Video panel access, 427
See also Video, Video clips

Tints
applying to grayscale photos 

(Camera Raw), 75
Black & White adjustment, 226, 228
Gradient Map adjustment, 228–229

Title clips, 429
Tonal adjustments

Black & White adjustment, 226–228, 
349

Brightness/Contrast adjustment, 212
Curves adjustment, 222–223
display calibration and, 201
dodging and burning, 233
Levels adjustment, 210–211, 238
redistribution (Camera Raw), 52
Shadows/Highlights command, 

230–232
Tone Curve tab (Camera Raw), 66–67
vignette creation via, 406

Tone Curve tab (Camera Raw), 59, 66–67
Tool Preset picker, 120

Tool presets
creating, 116, 120
default, restoring, 120
defined, 115
ideas for, 120

Tool Presets panel, 115, 120
Tool Tips

metadata in (Bridge), 37
preferences, 436
using, 100

Tools
Add Anchor, 102
Art History, 102
Background Eraser, 102
Blur, 102, 233
Brush, 101, 233, 271–276
Burn, 102, 233
Clone Stamp, 101, 262–263, 302–303
Color Replacement, 101, 292
Color Sampler, 101
Content-Aware Move, 101, 306–307
Convert Point, 102
Count, 101
Crop, 101, 127–133
Custom Shape, 102, 387, 392
Delete Anchor, 102
Direct Selection, 102
Dodge, 102, 233
Ellipse, 102
Elliptical Marquee, 101, 152, 154, 405
Eraser, 102, 282
Eyedropper, 101, 190
Freeform Pen, 102
Gradient, 102, 196, 198, 259
Hand, 90, 103
Healing Brush, 101, 294–296
hidden, selecting, 101
History Brush, 102, 109, 283–284
Horizontal Type, 102, 356–360
Horizontal Type Mask, 102
Lasso, 101, 153, 154
Line, 102
Magic Eraser, 102
Magic Wand, 101, 158–159
Magnetic Lasso, 101
Mixer Brush, 101, 278–282, 351
Move, 155, 175, 241, 243, 244–245, 

246, 332–333
Note, 101
opacity, 191
Option bar settings, 101
Paint Bucket, 102

Patch, 101, 298, 308
Path Selection, 102, 389–390
Pattern Stamp, 101
Pen, 102, 164
Pencil, 101
Perspective Crop, 101, 131
Polygon, 102
Polygonal Lasso, 101, 153
Quick Selection, 101, 156–157, 292
Rectangle, 102
Rectangular Marquee, 101, 152,  

154, 408
Red Eye, 101, 293
Rotate View, 91, 103
Rounded Rectangle, 102
Ruler, 101, 133, 270
selecting, 101
Sharpen, 102, 321
Single Column Marquee, 101, 152
Single Row Marquee, 101, 152
Slice, 101
Slice Select, 101
Smudge, 102
Sponge, 102
Spot Healing Brush, 102, 297
spring-loading, 101
Targeted Adjustment, 218, 222, 224, 

226
3D Material Drop, 102
3D Material Eyedropper, 101
Vertical Type, 102, 356–361
Vertical Type Mask, 102
Zoom, 89, 91, 103

Tools (Camera Raw), 56
Tools menu (Bridge)

Batch Rename command, 44
Cache command, 50
Photoshop submenu

Batch command, 397
Contact Sheet II command, 

416–417
Image Processor command, 462
Load Files into Photoshop 

Layers command, 248
Merge to HDR Pro command, 234
Photomerge command, 264
Process Collections in Photoshop 

command, 264
Tools panel

cycling through tools on, 101
Default Foreground and Background 

Colors option, 104, 185
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Edit in Quick Mask Mode option, 104, 
170, 171

Edit in Standard Mode button, 170
illustrated, 102–104
Screen Mode menu, 92, 93
Set background color option, 104, 185
Set foreground color option, 104, 185
Switch Foreground and Background 

Colors option, 104, 185
using, 101
See also Tools

TOYO Color Finder, 187
Tracking, type, 361
Tracks, video

adding to timeline, 426
applying adjustment layer to, 430
audio, 432
deleting, 427
See also Video

Transformations
applying, 332–333
Drop Shadow layer effect, 377
with Free Transform command, 

332–333
with Move tool, 332–333
objects, 332
via Options bar, 333
paragraph type, 366
selection border, 155
shortcuts, 333
with Smart Guides, 332
type, 360, 366
undoing, 333

Transition panel, 428
Transitions, video

adding, 428
defined, 425
duration, adjusting, 428

Transparency in GIF, 465
Transparency & Gamut preferences, 

144, 440
Trim command, 132
TRUMATCH color system, 187
Type

aligning, 356, 364
anti-aliasing, 357
attributes, changing, 358
baseline shift, 363
character styles, 365
characters, selecting, 358
color, 359
converting point/paragraph, 360

creating, 356–357
creating vector masks from, 392–393
deleting, 358
editable, 355
editing, 358
editing mode, exiting, 358
embossed leather, 384–385
fading, 362
font family/style, changing, 359
font size, changing, 360
formatting, 365
hyphenation, 364
importing as Smart Object, 250–251, 

357
justifying, 364
kerning, 361
leading, 361
OpenType, 363
orientation, 362
paragraph, 356, 360, 366
paragraph settings, 364
paragraph styles, 365
point, 356, 360
rasterizing, 368–369
recoloring, 359
repositioning, on image, 367
rusted metal, 384–385
scaling, 360
screening back, 367
selecting, 358
shapes, repositioning, 370
in spot color channel, 370
tracking, 361
transforming, 332–333, 340
transforming bounding box, 366
warp settings, 340

Type preferences, 357, 443

U
Undoing

Properties panel edits, 204
shortcuts for, 99
transformations, 333

Units & Rulers preferences, 16, 441
Unsharp Mask filter, 325–326

V
Vector masks

copying, 393
creating from custom shape, 392
creating from shape layer, 392
creating from type, 392–393
deactivating, 393

discarding, 394
function, switching, 394
moving, 394
repositioning, 393
working with, 393–394

Vector shapes
adding to layers, 391
advantages to using, 387
aligning for Web output, 388
aligning to one another, 391
anti-aliasing removal, 388
combining, 391
converting to pixels, 390
copying attributes among, 389
creating, 387–388
defined, 387
drawing, 388
editing, 388
pasting shapes from, 390
recoloring, 389
repositioning, 391
stroke styling, 390

Vertical Type Mask tool, 102
Vertical Type tool

in changing font size, 360
defined, 102
Options bar, 356, 359, 360
in recoloring, 359
in selecting type, 358
type creation, 356–357

Vibrance adjustments
applying, 219–221
desaturating layers with, 220
restoring color selectively with, 221
skin tones, 219

Video
adding still images to, 429
adjustment layer application to, 429
audio clips, 432
files, importing, 426
filter application to, 431
frames, defined, 425
keyframes, 425, 431
manual fade, 431
picture-in-a-picture, 431
playing, 427
rendering clips into movie, 432
reviewing, 427
terminology, 425
timeline, 425, 426
title clips, 429
tracks, 425, 426, 427
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transitions, 425
workspace setup for editing, 425

Video clips
adding transitions to, 428
applying adjustment layer to, 430
applying filters to, 431
defined, 425
deleting, 427
length, changing, 427
order, changing, 427
rendering, 432
speed, changing, 427
splitting, 428
title, 429
trimming by dragging, 427

View menu
Clear Guides command, 270
Extras command, 268, 332
Lock Guides command, 270
New Guide command, 270
Print size command, 125
Proof Colors command, 448, 449
Proof Setup command, 195, 448
Rulers command, 269
Show submenu, 162, 268, 269, 270
Snap command, 269, 270
Snap To submenu, 129, 155, 270

Vignettes
creating via Lens Correction filter, 407
creating via tonal adjustment and 

mask, 406
white-bordered, creating, 405

Vignettes (Camera Raw), 77

W
Warp command, 340
Watermarks

adding to images, 410–411
creating, 410
Digimarc, 411

Web
aligning shapes for, 388
file size, 463
GIF and JPEG compared, 463
GIF format, 465–466
JPEG format, 467–468
previewing optimization settings, 464
resolution and dimensions for, 13, 16, 

124, 463
Web Gallery

creating, 412–414
defined, 412

gallery preview, 413, 415
illustrated, 415
saving, 416
saving settings as preset, 415
slideshow in default browser, 415
templates, 412–413
uploading via Bridge, 416

White balance
adjustments (Camera Raw), 61
setting (Camera Raw), 60

White Balance tool (Camera Raw), 56
Window menu

Arrange submenu, 87, 88, 90, 91, 
240, 246

opening panels via, 99
Options bar, 98, 101
Workspace submenu, 92, 425

Windows
color management, turning off and 

printing in, 455
droplet usability in, 400
exiting Photoshop in, 22
launching Bridge in, 23
launching Photoshop in, 1
Save As dialog, 19
ZIP file creation, 462

Workflow Options dialog (Camera 
Raw), 58

Working spaces
CMYK, 457
current, assigning, 12
in imported files, 10
settings, 8

Workspace menu (Options bar), 92, 
96–98

Workspaces
choosing, 92
deleting, 97
editing, 97
resetting, 97
saving, 96–97
setting up for video editing, 425

Workspaces (Bridge)
changing, 28
choosing, 28–29
custom, 38
default, 26
deleting, 38
Essentials, 28, 29
Filmstrip, 28
Light Table, 28, 29
order, changing, 28

Preview, 28, 29
resetting, 38
saving, 38

Wrinkle removal, 294, 295, 298

Z
ZIP files, 462
Zoom

level, changing, 89–91
level, changing via Navigator panel, 90
level, changing via Zoom tool, 89
level, matching, in multiple 

documents 90
in multiple document windows, 91
shortcuts, 89

Zoom tool
defined, 103
Scrubby Zoom, 89
zoom level changes with, 89, 91

Photography credits
Shutterstock.com
Photographs on the following pages  
are © ShutterStock.com: 1, 33, 40, 42, 
45, 49, 57, 61, 66, 72, 76, 77, 80, 85, 88, 
91, 92, 121, 123, 125, 126, 127, 128, 
129, 131, 134, 136, 137, 139, 146, 151, 
152, 153, 154, 155, 156, 158, 159, 160, 
161, 162, 163, 166, 170, 171, 177, 182, 
183, 184, 186, 192, 193, 201, 202, 204, 
207, 210, 212, 213, 214, 216, 218, 219, 
220, 221, 222, 228, 230, 240, 242, 243, 
245, 250, 251, 252, 255, 256, 260, 262, 
266, 272, 280, 283, 285, 286, 288, 294, 
296, 297, 298, 299, 300, 302, 305, 306, 
307, 308, 309, 311, 313, 314, 315, 318, 
321, 322, 325, 327, 335, 336, 337, 338, 
340, 341, 345, 349, 350, 351, 352, 353, 
357, 362, 373, 375, 376, 380, 381, 383, 
386, 388, 392, 393, 394, 405, 406, 407, 
408, 409, 412, 413, 415, 416, 433, 447, 
450, 454

Gettyimages.com
Pages 14, 291, 332, 341, 366

Other photographs
Page 25 Wayne Palmer © Palmer 
Multimedia

Page 467 © Victor Gavenda

All other photographs © Elaine 
Weinmann and Peter Lourekas




